CAT-100
ATMOSPHERIC CARBON POTENTIAL ANALYZER
OPERATIONS MANUAL

Super Systems Inc.
7205 Edington Drive
Cincinnati, OH 45249
513-772-0060
Fax: 513-772-9466
www.supersystems.com
Table of Contents

Introduction.............................................................................................................................. 5
CAT-100 Specifications............................................................................................................. 6
Replacement Parts..................................................................................................................... 6
Testing Procedure..................................................................................................................... 8
  Unpacking and Charging the CAT-100.................................................................................... 8
  Entering the Coil Factor......................................................................................................... 8
  Preparing the Insertion Rod with Steel Wire Coil................................................................. 11
  Using the Insertion Rod in the Testing Environment............................................................ 13
  Cooling Down and Removing the Insertion Rod................................................................. 15
  Using the Emery Cloth on the Steel Wire Coil.................................................................... 16
  Attaching the Steel Wire Coil to the Binding Posts............................................................. 16
  Storing Test Results............................................................................................................ 18

CAT-100 Menu Navigation.................................................................................................... 21
  Note about Battery Level Indicator...................................................................................... 22
  Main................................................................................................................................... 22
  Detail................................................................................................................................... 23
    Coil Factor and Advanced Detail Display (Configuration Mode)......................................... 23
  Review Tests......................................................................................................................... 24
  About................................................................................................................................... 24

  LOGIN................................................................................................................................. 25
  Calibration............................................................................................................................ 25
  Coil TC Calibration.............................................................................................................. 27
  Comms Setup [Communications Setup]............................................................................... 27
  Ethernet Setup..................................................................................................................... 28
    DHCP Button..................................................................................................................... 29
  Update................................................................................................................................ 30
  View Updates....................................................................................................................... 30
  General Setups..................................................................................................................... 31
    Temperature Mode............................................................................................................ 32
    Date/Time Set.................................................................................................................... 32
    Display Theme.................................................................................................................. 33
  Factory Defaults................................................................................................................... 33
  Clear Tests............................................................................................................................ 33
  Test Enables......................................................................................................................... 33
Introduction
The Super Systems Inc. (SSI) CAT-100 is an Atmospheric Carbon Potential Analyzer that provides a measurement of Carbon Potential in a positive pressure atmosphere. This measurement is determined by measuring specific properties of a steel wire coil that has been inserted into an atmosphere with a carbon-bearing gas for a predefined amount of time. The CAT-100 system is designed to provide accurate results in a cost-effective manner.

Figure 1 - CAT-100 Carbon Potential Analyzer

The concept behind the CAT-100 is similar to the concept behind the SSI Shim Port with Shim Stock. The CAT-100 is designed to provide an on-site carbon measurement. More information on this process can be found in the Testing Procedure section on page 8.
CAT-100 Specifications

Carbon Potential Measurement Specifications
Range: 0.1% to 1.3% Carbon Potential
Read Time: 30 to 45 seconds per coil

Accuracy
Accurate to within ±0.03% Carbon Potential

Operating Temperature
50°F to 100°F (10°C to 37°C)

Power
Input Power Range: Universal, 85 – 264 VAC
Input Frequencies Supported: 50 Hz, 60 Hz
Batteries: NiMH (up to 6 hours of continuous operation)

Dimensions
Length of front and rear plates: 12.5 inches
Length of sides: 10.5 inches
Height: 5.5 inches

Weight
9.5 lbs. (approx. 4.31 kg)

Touch Screen
Type: Resistive, TFT LCD
Size: 4.3”

Standard Insertion Rod
Maximum extension length: Approximately 41.4”. Requires 1” NPT connection on furnace access port. Visit www.supersystems.com for additional documentation on this procedure.

Extended Insertion Rod
Maximum extension length: Approximately 54.4”.

Replacement Parts
Contact SSi at (513) 772-0060 to order parts.
<table>
<thead>
<tr>
<th>Part Number</th>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>13569</td>
<td>CAT-100 Complete Unit</td>
<td>CAT-100 retail unit. Includes all components in an assembled unit.</td>
</tr>
<tr>
<td>13497</td>
<td>Standard Insertion Rod</td>
<td>The rod used to properly insert the steel wire coils into a carbon-containing atmosphere. Typically, the rod is inserted into the atmosphere through an access port on the furnace or other piece of equipment.</td>
</tr>
<tr>
<td>13694</td>
<td>Extended Insertion Rod</td>
<td>13” longer than the Standard Insertion Rod</td>
</tr>
<tr>
<td>20616</td>
<td>Cage Assembly for Insertion Rod</td>
<td>The piece that attaches to the insertion rod and surrounds the steel wire coil</td>
</tr>
<tr>
<td>20767</td>
<td>Calibration Bridge</td>
<td>The module used to perform a circuit calibration on the CAT-100. See Calibration section (page 25).</td>
</tr>
<tr>
<td>20753</td>
<td>Bag of 100 Coils</td>
<td>Steel wire coils that are inserted into a carbon-containing atmosphere for testing purposes. <strong>NOTE:</strong> The % Carbon content of the untested coils will be imprinted on this bag. The Coil Factor will also be printed on the bag.</td>
</tr>
<tr>
<td>30058</td>
<td>Emery Cloth (Fine Grade, 150 Grit)</td>
<td>A cloth containing coarse material used with the steel wire coil prior to carbon analysis.</td>
</tr>
<tr>
<td>13564</td>
<td>Carrying Case Assembly</td>
<td>Carrying case used to transport and provide protection for the CAT-100 unit</td>
</tr>
<tr>
<td>34601</td>
<td>Hinged Standoff</td>
<td>The long, thin metal standoffs on the front of the unit that support it</td>
</tr>
<tr>
<td>34557</td>
<td>CAT-100 Handle</td>
<td>Handle attached to the top of the polycarbonate enclosure</td>
</tr>
<tr>
<td>32016</td>
<td>Battery</td>
<td>Replacement battery for CAT-100</td>
</tr>
<tr>
<td>33018</td>
<td>Power Cord</td>
<td>Power cord used with CAT-100</td>
</tr>
<tr>
<td>20759</td>
<td>Custom Foam Packaging</td>
<td>Specially designed packaging material used to protect the CAT-100 from damage during transport or storage</td>
</tr>
<tr>
<td>20756</td>
<td>Enclosure</td>
<td>The enclosure that covers the CAT-100 unit</td>
</tr>
</tbody>
</table>

**Table 1 - Replacement Parts List**
Testing Procedure

Unpacking and Charging the CAT-100

Carefully remove the packing tape from the box in which the CAT-100 was shipped and remove the CAT-100, right side up. Using proper lifting technique, place the CAT-100 on a level surface.

If you are going to use the CAT-100 without electrical outlet power, allow the unit to charge overnight before use. Do this by simply plugging the unit into an AC electrical outlet and allowing it to charge. Make sure that the unit is charging with the power turned OFF.

Entering the Coil Factor

The **Coil Factor** for the wire coil is used in calculating Carbon Potential and is based on variations in coils in a batch. The **recommended** Coil Factor is printed on each bag of coils and is the same for all coils in a batch. Before using the coil in the testing process, follow this procedure for entering and verifying the Coil Factor. **It is essential that this procedure be followed correctly.**

First, note the recommended Coil Factor printed on the bag of coils that the coil you are using came from. If you do not have the bag, assume a Coil Factor of **100**.

Next, log in with Configuration Mode on the CAT-100 by following these steps:

From the main status screen, push the menu button.
Open the Detail menu from the main menu. The Detail screen will be shown, and the Coil Factor will be displayed in a box labeled "Factor". Tap on that box to continue.

A numeric entry screen will appear. Enter the Coil Factor that you noted earlier for the wire coil (or enter 100 if you do not have the Coil Factor available).
The Detail screen will now show the Coil Factor that you entered.

Return to the CAT-100 main status screen.

Attach the wire coil to the binding posts *using the small holes on the sides of the posts*, as illustrated in Figure 8 and Figure 9. Make sure to tighten the binding posts by turning each screw clockwise; do not overtighten. Also, do not allow the coil to make contact with the external thermistor.
Once the coil is attached to the binding posts, note the %Carbon displayed on the CAT-100. The % Carbon should be as close to 0.83 as possible, or within the range of .83 ± .03. In order to increase the %C, increase the Coil Factor. In order to decrease the %C, decrease the Coil Factor.

Preparing the Insertion Rod with Steel Wire Coil

The wire coil is designed to be placed in the testing atmosphere with the use of a metal insertion rod that can be purchased from SSi. The parts of the insertion rod, shown in Figure 1, are as follows:

- **Shaft.** A long metal shaft supports the working end of the insertion rod (where the wire coil is housed) and allows the rod to span the length of a typical furnace access conduit.
- **Threaded port connector.** The port connector is designed to attach to, and provide a tight connection with, the access port on a furnace. NOTE: The connector is designed for a 1” NPT connection.
- **Protective cage.** The protective cage provides housing for the wire coil when the coil is attached to the insertion rod.
- **Rod screw.** The rod screw, which screws into the shaft through the protective cage, helps keep the protective cage in place on the insertion rod.
NOTE: After repeated use, the insertion rod will gradually turn from its silver, “out of the box” color to a charcoal black color. This is due to the rod’s placement in the furnace atmosphere and does not affect its function.

To prepare the insertion rod for placement in a testing atmosphere, first slide the “wound” portion of the wire coil over the rod screw (Figure 10).

**IMPORTANT!**

The wire coil must be placed on the rod screw, not on the protective cage.

Next, slide the rod screw through the opening in the protective cage (Figure 11).
Finally, insert the protective cage and rod screw into the insertion rod (Figure 1); hand tighten the rod screw until it screws into place tightly on the insertion rod. Ensure that the “legs” of the protective cage are inserted into the metal stopper on the insertion rod.

**IMPORTANT:** Hand tighten rod screw until it screws tightly in place on insertion rod.

Using the Insertion Rod in the Testing Environment

The insertion rod is now ready to be placed in the testing atmosphere. Since the testing atmosphere will be extremely hot, placement in the testing atmosphere is usually accomplished by extending the insertion rod through an access port in the furnace.

**WARNING!**

Use ANSI-approved eye protection at all times when working with the insertion rod in a plant or other testing environment. Take any additional precautions necessary to lower the risk of injury in the environment in which you are working.
With the wire coil in place on the insertion rod, place the insertion rod through an access port or other designated conduit. Begin hand-tightening the threaded port connector by turning the connector clockwise. See Figure 10.

![Figure 10 - Placing insertion rod in access port and tightening threaded port connector](image)

Using a wrench, turn the port connector clockwise to finish tightening it (Figure 11). Take care not to overtighten the connector.

![Figure 11 - Tightening port connector with wrench](image)

Push the insertion rod until the wire coil is present in the testing atmosphere. The wire must now soak in the atmosphere; the amount of time to soak the wire is based on the temperature in the testing atmosphere. Table 2 shows the appropriate soak times.

<table>
<thead>
<tr>
<th>Temperature in Testing Atmosphere</th>
<th>Soak Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1575°F and higher</td>
<td>30 minutes</td>
</tr>
<tr>
<td>1574°F and below</td>
<td>40 minutes</td>
</tr>
</tbody>
</table>

*Table 2 - Soak times based on temperature in testing atmosphere*
**NOTICE!**

Exceeding indicated soak times by more than 5 minutes may result in adverse effects on carbon potential readings when the wire coil is tested with the CAT-100.

---

**Cooling Down and Removing the Insertion Rod**

**WARNING!**

Use ANSI-approved eye protection at all times when working with the insertion rod in a plant or other testing environment. Use heat-resistant hand protection when removing the insertion rod from the testing environment. Take any additional precautions necessary to lower the risk of injury in the environment in which you are working.

**NOTICE!**

Do not immerse the insertion rod or wire coil in water or any other substance other than ambient air or test environment air at any time. Doing so could damage equipment and will invalidate the results of any carbon potential test.

Put on heat-resistant full hand protection (such as welding gloves) before proceeding.

Once the appropriate soak time has been achieved, the insertion rod is ready to be removed. **Proper removal of the insertion rod is essential for achieving accurate carbon readings.** Follow these steps for proper removal.

**Recommended:** Measuring tape; stopwatch or watch with seconds indication.

1. Retract the first 6” (six inches) of the insertion rod length from the access port.
2. Pause for one minute.
3. Retract another 3” (three inches) of the insertion rod length from the access port. Pause for another minute.
4. Repeat Step 3 as many times as needed until the protective cage makes contact with the ball valve (Figure 12).

---

*Figure 12 - Removing insertion rod from access port*
5. Once the insertion rod is fully retracted, leave it in place for a minimum of three minutes.
6. Close the access port valve.
7. Remove the insertion rod completely from the access port.

**NOTICE!**

Do **NOT** quench in water; air cool only. If a method of cooling other than air cooling is utilized, test results will be unreliable.

Using the Emery Cloth on the Steel Wire Coil

Before the wire coil is attached to the CAT-100 for analysis, the two ends of the wire should be cleaned. An emery cloth is provided for this purpose. It is recommended that each wire end be lightly cleaned with emery cloth, as pictured in Figure 13.

![Figure 13 - Using emery cloth on wire coil](image)

**IMPORTANT!**

The correct type of emery cloth must be used for acceptable results. SSi sells a fine grade, 150 grit emery cloth for use in this process. See the Extended Insertion Rod Maximum extension length: Approximately 54.4”.

Replacement Parts list (page 7) for more information.

Attaching the Steel Wire Coil to the Binding Posts

Attach one of two wire coil leads to the hole *on the right side* of one of the two binding posts, as shown in figures 18 and 19. Be sure to insert the coil lead until it touches the back of the post (note the contact points in Figure 18). Then tighten the post to secure the lead. Repeat this procedure for the second lead.
**IMPORTANT!**

Each lead must touch the back of the post to ensure the correct length of insertion. Note the red arrows in Figure 14.

![Figure 14 - Attaching wire coil to binding posts](image_url)
Once the wire coil is secured to the binding posts, close the protective cover on the CAT-100.

**IMPORTANT!**

Ensure that the wire coil does not make contact with the external thermistor once the wire is attached to the binding posts. The location of the external thermistor is noted in Figure 14.

**Storing Test Results**

Leave the wire coil attached to the binding posts for **30 to 45 seconds**. During this time, the % Carbon reading will likely fluctuate. This is expected and is not an error. After 30 to 45 seconds, press the button to save the setting to the CAT-100’s internal storage.

Depending on which options are enabled in the Test Enables menu (see page 33), a series of screens will appear. If one or more of these options are **NOT** enabled in the Test Enables menu, that screen[s] will **NOT** appear.

- **Test ID Entry** [Figure 16]. This screen gives you the ability to enter an identification number for the test data that you are saving. When finished, press à to continue.
• **Furnace # Selection** (Figure 16). With this screen, you may select a furnace number to associate with the saved test data. Furnace names may be edited in the CAT-100 PC software; see the **View Furnaces** section on page 44 for more details. The maximum number of furnace names is 16; the maximum number of characters for each name is 32.

![Furnace # Selection](image)

**Operator # Selection** (Figure 17). With this screen, you may select an operator number to associate with the saved test data. Operator names may be edited in the CAT-100 PC software; see the **View Operators** section on page 44 for more details. The maximum number of operator names is 16; the maximum number of characters for each name is 32.

![Operator # Selection](image)

• **Enter probe data** (Figure 18). Using this screen, probe data may be saved with the test data: % Carbon ("%C"), millivolts ("MV"), thermocouple number ("TC"), and CO Factor ("COF"). Pressing each button associated with a field will bring up a numeric keypad that will allow you to enter the appropriate value for that field. When finished entering values, press ‹ to continue.
Enter date and time of test (Figure 19). This screen contains buttons allowing you to enter the Year, Month, Day, Hour, and Minute of the test. You may also accept the default values shown. When finished entering values, press \( \text{↵} \) to continue.

The screen will read “Test Saved!” (see Figure 20) when the test data has been saved. A summary of the data saved will then be shown (Figure 21) before the main menu is again displayed.

Once the data has been saved appropriately, remove the wire coil from the binding posts. Discard the wire coil in a proper manner. **To prevent errors in test results, it is important not to reuse a coil that has already been used.**
CAT-100 Menu Navigation

Most of the CAT-100’s functional details and settings are accessed by using the CAT-100 menu.

To open the menu from the main screen, press the “Menu” button located in the upper right hand corner of the touch screen, as shown in Figure 22.

![Figure 22 - Main Screen with Menu button](image)

A number of menu items will be visible.

User Level
- Main
- Detail
- Review Tests
- About
- LOGIN

Supervisor Level [Default Code: 1]

*All of the above options and these:*
- Calibration
- Coil TC Calibration
- Comms Setup (Communications Setup)
- Ethernet Setup
- Update
- View Updates

Configuration Level [Default Code: 2]

*All of the above options and these:*
- General Setups
  - Temperature Mode
  - Date/Time Set
  - Display Theme
  - Factory Defaults
  - Clear Tests
- Test Enables
- Touch Cal (Touch Calibration)
- Pass Code Set
- Language
Figure 23 shows an example of a CAT-100 menu list. The menu items are described in more detail in the subsections below.

![Figure 23 - CAT-100 Menu List](image)

**Note about Battery Level Indicator**
The CAT-100 includes a battery level indicator which is displayed on the bottom of many screens. The battery level indication will change as the battery discharges. When the battery is nearly depleted of its charge, the indicator will change to a red color. Examples are shown in Figure 24.

![Fully Charged  About 50% Charged  Almost Empty](image)

**Main**

The Main menu option will open the main status screen (pictured in Figure 30). From this screen, you can see Carbon Potential data and coil temperature for a properly attached wire coil.

![Figure 30 - Main Status Screen](image)

If no coil is detected, or if the Carbon Potential cannot be calculated, the % Carbon will be displayed as “NS” (“No Sample”).

The main status screen will be used during a typical coil testing procedure. Refer to the
Testing Procedure section (page 8) for further details on this process.

**Detail**

The Detail menu will open the Detail screen (Figure 31), which displays current values for % Carbon, coil temperature (the temperature detected for the wire coil), and internal temperature (the temperature detected inside the CAT-100).

![Figure 31 - Detail Screen](image)

Press the button to return to the menu list.

**Coil Factor and Advanced Detail Display (Configuration Mode)**

By logging in with configuration mode (see LOGIN section on page 25), you can:

- View and set the ** Coil Factor ** (shown as “Factor”) and
- View additional information on resistance, voltage, and current.

An example screen is shown in Figure 25.

![Figure 25 - Coil Factor and Advanced Display on Detail Screen (Configuration Mode Login Required)](image)

Each wire coil has a Coil Factor associated with it. The Coil Factor is critical in accurate Carbon Potential calculations and can be found printed on each bag of wire coils. More information on how the Coil Factor is used and set can be found in the Entering the Coil Factor section on page 8.
Review Tests

The Review Tests menu contains a record of recorded test results. When opened, the menu will present a list of test results (Figure 26).

![Review Tests Screen](image)

To view more detailed information on a specific test, use the ↑ and ↓ buttons to scroll to the desired test result, and then press the ↵ button. A screen similar to the one pictured in Figure 27 will be shown.

![Detailed Test Results](image)

Press ↑ to return to the list of recorded test results.

Once you are finished reviewing test results, press the → button to return to the menu list.

About

Selecting the About menu option will bring up the About screen (similar to the screen shown in Figure 28). This is the same screen that is shown when the CAT-100 first starts up.
LOGIN

The purpose of the LOGIN option (Figure 29) is to allow the user to access Supervisor and Configuration functions. Enter the Supervisor pass code (default is 1) to log in with the Supervisor access level. Enter the Configuration pass code (default is 2) to log in with the Configuration pass code. Functions available with each access level are shown in the CAT-100 Menu Navigation section on page 21.

Calibration

A circuit calibration is **required** once per year and **recommended** every four months. The required annual calibration is performed by SSi, and a certificate is issued for this calibration. A circuit calibration can be performed by the end-user by using the Calibration Bridge provided by SSi when the CAT-100 is first shipped.

An important guideline is as follows: **A circuit calibration should be performed at any time the “Error in %” found in this procedure is greater than 0.5 or less than -0.5.**

**NOTE:** Information on ordering a replacement Calibration Bridge can be found in the *Extended Insertion Rod*
Maximum extension length: Approximately 54.4".
Replacement Parts section (page 6).

The Calibration screen allows you to perform the circuit calibration. The procedure is as follows.

1. Open the Calibration menu option. Doing this will require a Configuration level access code.

![Figure 30 - Calibration menu screen](image)

2. Connect the Calibration Bridge to the binding posts (It is *not* necessary to sand the calibration bridge). Do this by first inserting the **long end** of the Calibration Bridge into a binding post first, tightening that post, then inserting the **short end** of the Calibration Bridge in the other binding post, and tightening that post. See Figure 31.

![Figure 31 - Calibration Bridge in CAT-100 Binding Posts](image)

3. Wait five (5) minutes. This will allow “Error in %” readings to stabilize. The screen will display a countdown during the calibration process (See Fig. 38 above).

4. Press the **button** to calculate and store the calibration value. The “Error in %” should now be equal to zero (0). If “Error in %” does not read zero (0) on the first attempt, press **button** to recalculate and store the calibration value.
**IMPORTANT!**

The maximum allowable “Error in %” range is ±0.5. If the “Error in %” is greater than 0.5 or less than -0.5 after you have pressed the κ button more than twice, contact SSi at (513) 772-0060 for further assistance.

Press the κ button to return to the menu list.

Coil TC Calibration

The CAT-100 contains a thermistor used to measure ambient temperature in the area near the binding posts to which the steel wire coil is attached for carbon analysis. This thermistor must be calibrated annually.

To calibrate, first press the Coil TC Calibration button. Using a digital thermometer with accuracy of ±0.1°C (±0.18°F), measure the ambient temperature within ¼” of the thermistor (see Figure 32). Enter this value in the Coil TC Calibration screen (Figure 40). The “Coil Temp” value will change to the value you entered.

Press the κ button to return to the menu list.

Comms Setup (Communications Setup)

The Comms Setup screen allows you to change communications settings of the serial and USB connections for the CAT-100. Use the ↑ and ↓ buttons to change which setting is selected.

Press the κ button to change a setting. **In most cases, these settings will not need to be changed from their defaults.**
The settings are as follows:

- **RS-485 Baud**: The baud rate (data transmission rate) of the RS-485 serial connection. 19200 is default.
- **RS-485 Mode**: The mode of the RS-485 serial connection. Master is default. Host may also be selected.
- **USB Baud**: The baud rate (data transmission rate) of the USB connection. 115200 is default.

To change the value for a selected setting, use the ↑ and ↓ buttons. When finished, press the ↵ button.

Press the ← button to return to the menu list.

**Ethernet Setup**

The Ethernet Setup menu (Figure 33) allows you to change settings for the network adapter on the CAT-100. The following settings can be changed:

- **Address (IP Address)**: The IP address of the CAT-100.
- **Subnet Mask**: The subnet mask for the CAT-100. If you intend to create an Ethernet connection between the CAT-100 and a computer, all of these values must match the subnet mask of the computer you are using to connect to the CAT-100.
- **Gateway**: The IP address of the router or network device that manages traffic on the network.
Each of the numeric values may be changed by first tapping the numerical block and then using the numeric keypad to enter a new value.

**IMPORTANT!**

If you are uncertain of the correct network settings for the CAT-100, first consult your network administrator. Incorrect network settings may cause the CAT-100 to be unusable on the network and may even cause network problems for other devices on the network (such as computers and other connected instruments).

Press the button to return to the menu list.

**DHCP Button**

The **DHCP** button (Figure 34) turns on dynamic IP address assignment. When DHCP is on, the CAT-100 will request an IP address from the network server. This IP address may change over time.

If dynamic IP addressing is turned ON, a message will appear to the right of the “Address” text. The message will read “DHCP,” followed by an IP address. This is the dynamically assigned IP address that the CAT-100 is using. When dynamic IP addressing is turned ON, the message “DHCP” will also appear on the main screen.
To turn dynamic IP addressing OFF, enter a static IP address. The CAT-100 will switch to manual Ethernet settings.

In order to leave dynamic IP addressing ON, press the ↩ to exit the Ethernet Setup menu.

**Update**

The Update menu (Figure 35) is used to perform an automatic update of operating parameters. In order for the update to work, the CAT-100 must be connected to an Ethernet network with Internet access. Press the “START” button to begin downloading the calculation update.

![Update Screen](image)

**Figure 35 - Update Screen**

**NOTE:** If the CAT-100 is connected to a network with Internet connectivity but fails to update properly using this menu, turn on dynamic IP assignment (following the procedure described in the DHCP Button section on page 29) and try the update again. If you continue to have problems after doing this, please call SSi at (513) 772-0060.

Press the ↩ button to return to the menu list.

**View Updates**

The View Updates screen (Figure 36) allows you to view a log of calculation method changes and when they were applied. Pressing ↩ will load the highlighted calculation method, and the CAT-100 will use that method to calculate % Carbon.
Press the button to return to the menu list.

**General Setups**
The General Setups menu (Figure 37) contains five submenus used to control various settings, reset the CAT-100 to factory default settings, and reset test numbering.
**Temperature Mode**

The Temperature Mode menu (Figure 38) allows you to select one of two temperature modes for displaying and recording data. These two modes are Fahrenheit and Celsius.

![Figure 38 – Temperature Mode selection](image)

**Date/Time Set**

The Date/Time Set menu (Figure 39) allows you to set the current date (Year, Month, and Day) and time (Hour, Minute, and Second) manually.

![Figure 39 – Date/Time selection](image)
Display Theme
Using the Display Theme menu, you may choose one of three display modes: white text on black background, black text on white background (default), or white text on gray background.

![Display Theme selection](image)

Figure 40 – Display Theme selection

Factory Defaults
Pressing this button will revert CAT-100 settings such as operating parameters, equipment (furnace) numbers, and operator numbers to factory defaults. The static IP address (if assigned) is not changed.

Use care when selecting this option, as any settings that were changed before factory defaults are reset cannot be recovered.

Clear Tests
Pressing this button will erase the first character of each stored test and restart test numbering at 0.

Test Enables
The Test Enables screen (Figure ) allows you to toggle whether data for the following are enabled or disabled:
- Test ID
- Equipment
- Operator
- Date/Time
- Probe Data
**Touch Cal (Touch Screen Calibration)**

Using the Touch Screen Calibration option (Figure 50), you will be able to set up the CAT-100 touch screen for optimal touch response. Using a stylus, press and hold the center of each numerical block for a period of 10 seconds, as instructed on the screen. Once all of the blocks have turned green, press the DONE button.
Pass Code

Use the Pass Code screen (Figure 41) to change the default Supervisor and Configuration pass codes. Simply press the pass code type you would like to set, enter the new code on the numeric keypad, and then press \( \rightarrow \) to save the newly entered pass code.

![Pass Code Screen](image)

Press the \( \rightarrow \) button to return to the menu list.

Language

The CAT-100 provides several language options. Use the Language menu to change which language the CAT-100 uses for operation.

Press the Language Update button to update the language definition file. An Internet connection to the CAT-100 is required for this to work.

Press the \( \rightarrow \) button to return to the menu list.
CAT-100 PC Software (CAT-100 View)

When purchased, the CAT-100 is provided with PC computer software, **CAT-100 View**, that can be used to download and store data on the PC as well as display data in grid form and in a line graph. CAT-100 View connects to the CAT-100 using a USB or Ethernet connection.

**Installation**

Installation files for CAT-100 View are provided on a CD that is shipped with the CAT-100. Insert the CD into a compatible disc reader to begin the installation process. The installation CD contents will look similar to what is shown in Figure 42. To install CAT-100 View, double click on the “setup” or “setup.exe” file.

![Figure 42 - Example contents of installation CD](image)

CAT-100 View Setup will run. Figure 43 shows an example of what the installation screens may look like. The Setup procedure will ensure that all prerequisites for using CAT-100 View are installed, in addition to the CAT-100 View software itself.
Once installed, CAT-100 View can be opened from the Windows Start menu.

**CAT-100 USB Driver**
The CAT-100 can be connected to a PC using an Ethernet connection or USB. In most cases, Windows will detect the CAT-100 and install the USB driver that is needed for the computer to access CAT-100 data via USB. In some cases, Windows will not be able to successfully install the driver, in which case it will need to be installed manually. This can happen, for example, if the computer to which the CAT-100 is connected does not have Internet access.

To install the USB driver manually, follow these steps:
1. Ensure that the CAT-100 is not connected to the computer. Remove any USB cables and Ethernet cables from the CAT-100.
2. Insert the installation CD provided with the CAT-100 into the computer’s disc reader.
3. Open the installation CD in Windows Explorer. Find the file named `CDM v2.08.30 WHQL Certified.exe`. This is the driver installation program.
4. If using Windows XP, double click on the driver installation program. If using Windows Vista, 7, or 8, right click on the driver installation program and select **Run as administrator** (you will need to confirm this action).
   
   **NOTE:** The program must be run with administrator privileges in order to work correctly.
5. Extract the driver installation files by clicking **Extract**. A driver installation window will appear once all files are extracted.
6. Click **Next** to install the drivers.

   Once the drivers are installed successfully, a window will appear showing the successful installation.

7. Restart the computer.

   If you encounter problems with this procedure, contact SSi by calling (513) 772-0060.

**Main Screen**
The main screen is what appears when CAT-100 View is first opened. In order to utilize most of this screen, data must first be downloaded from a CAT-100 unit. This is performed with the
Manage CAT100s option described on page 43.

Figure 44 shows the layout of the CAT-100 View main screen. Lettered labels in Figure 44 correspond to descriptions in Table 3 - Main Screen options and Table 4 - Main Screen display fields.

![Figure 44 - CAT-100 View main screen](image)

<table>
<thead>
<tr>
<th>Main Screen Options</th>
<th>Label in Figure 44</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Saved CAT100s drop-down list</td>
<td>Opens a list of CAT-100 units that have been accessed by the program previously. When a CAT-100 unit is selected, data that has been downloaded for that unit is displayed.</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Test Info button</td>
<td>Opens a window containing information on a highlighted test</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Edit Test button</td>
<td>Allows for the modification of highlighted test data [NOTE: This does NOT change the data on the CAT-100 itself]</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Delete Tests button</td>
<td>Deletes highlighted test data</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Show Live Coil button</td>
<td>Displays coil data from a connected CAT-100</td>
<td></td>
</tr>
</tbody>
</table>

[NOTE: If no CAT-100 data is loaded, the buttons (B, C, D, & E) will be grayed out.]

<table>
<thead>
<tr>
<th>Main Screen Display Fields</th>
<th>Label in Figure 44</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Test Number</td>
<td>The saved test number</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>Test ID</td>
<td>The test ID (user-provided)</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Time</td>
<td>The time of the test recorded by the CAT-100</td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>Furnace</td>
<td>The saved furnace number (user-provided)</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td>Operator</td>
<td>The saved operator identifier (user-provided)</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>Coil %C</td>
<td>The recorded carbon potential of the coil used in the selected test</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>SP %C</td>
<td>The carbon value of the process that is entered in the CAT-100 unit during the soak of the coil (user-provided)</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>SP °F</td>
<td>The temperature setpoint (may be displayed in °C or °F; user-provided)</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>Avg Coil %C</td>
<td>The average carbon potential for a particular Test ID</td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>Deviation</td>
<td>The difference between the Coil.%C and the SP %C</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>Notes</td>
<td>Test notes [added in CAT-100 View]</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>Probe mV</td>
<td>The probe millivolts (user-provided)</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>COF</td>
<td>The CO factor (user-provided)</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>Probe Temp °F</td>
<td>The probe temperature [may be displayed in °C or °F; user-provided]</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>Coil Factor</td>
<td>The Coil Factor used in Carbon Potential calculation [entered by user during testing procedure]</td>
<td></td>
</tr>
</tbody>
</table>

With the exception of the Test Number, all of the fields can be changed by the user. When a field is changed, it is changed in CAT-100 View, but not on the CAT-100 itself.
**Sorting Data in the Main Screen View**

The main screen provides a way to sort data based on one field by clicking on that field’s column heading. For example, if you want to sort test results in order of time, simply click on the **Time** column heading. By default, sorting will be performed in **ascending** order. In the case of time, this means that the least recent time will be shown first. To change sorting order to **descending**, click on the column heading again. Again using the example of time, a descending order will display the most recent time first. This example is depicted in Figure 45.

![Figure 45 - Simple field sorting in CAT-100 View](image)

For more advanced sorting options, see a description of the Sort menu on page 45.

**File Menu**

The **File** menu (Figure ) contains three options: **Show Graph**, **Export Tests to CSV**, and **Print Selected Tests**.

**Show Graph**

The **Show Graph** option displays CAT-100 data in line graph form. This is derived from the data presented in the grid form displayed on the CAT-100 main screen. An example of a graph is shown in Figure 46.
**Export Tests to CSV**

This option allows you to save downloaded CAT-100 data in a comma-separated value (CSV) file that can be opened with a program such as Microsoft Excel. To save a CSV file and use it in Excel, follow these steps.

1. Save the CAT-100 data to a CSV file using the Export Tests to CSV option in CAT-100 View (see example in Figure 47).

2. Open Microsoft Excel (or a similar spreadsheet program). Open the File -> Open dialog box (Figure 47). Set the File Type to include .csv files. Select the CSV file you saved and click Open.
The rest of this section pertains to Microsoft Excel. However, other spreadsheet programs will likely have similar functionality.

3. Choose “Delimited” for the “Original data type” (Figure 1). Click **Next**.

4. Set the Delimiter type to “Comma” (Figure 48). Then click **Next**.

5. The “Column data format” can be configured for each column using the options in Excel (Figure 49). “General” format should work well in most cases. Click **Finish** when ready.
6. Observe how the data is organized in Excel (see an example in Figure 50). Make changes to the formatting as needed.

**Print Selected Tests**
This option allows for the printing of selected CAT-100 data to a printer (see example Print Options window in Figure 51).

**Options Menu**
The **Options** menu (Figure 52) provides the **Manage CAT100s** and **Temperature Scale** options.
Manage CAT100s

The Manage CAT100s menu is used to search for CAT-100 units via Ethernet or USB (see example in Figure 53). Once units are found, this option allows the PC to connect to a selected CAT-100, download data from it, and perform additional operations.

NOTE about USB connections: If you experience difficulty connecting the CAT-100 to the computer using USB, refer to the CAT-100 USB Driver section on page 37.

![Finding and selecting CAT-100s for management options](image)

Figure 53 - Finding and selecting CAT-100s for management options

NOTE: Once CAT-100 View connects to a CAT-100 via USB or Ethernet, that CAT-100 can be connected to using the Saved CAT100s drop-down menu in the CAT-100 View main screen.

The following options are available:

**Download New Tests.** When this button is clicked, CAT-100 View downloads all new test values from the CAT-100 unit. New test values are those that have not been downloaded previously.

**Download Options.** This option (Figure 54) provides several parameters for downloading test results from the CAT-100 unit.

![Download Options](image)

Figure 54 - Download Options

The first parameter is **Next Test Number To Download.** This specifies the test number at which CAT-100 View starts downloading test results. Any number less than that test number will not be downloaded. If the number specified for the Next Test Number does not exist, nothing will be downloaded.
The second parameter is **Current Download Group**. This allows you to assign a group number to the test data that will be downloaded when **Download New Tests** is clicked. In the main screen, the Test ID will display a value based on the following formula when a Group Number has been assigned to downloaded results: \((\text{Group Number } \times 10000) + \text{Test Number}\).

The third parameter is **Download Range Tests** (Figure 55). This option allows you to set a range of tests that CAT-100 View will download from the CAT-100 unit. The test number in the “Start” field must exist in order for any values to be downloaded in this range.

**View Furnaces** (Figure 56). Selecting this option will display the list of Furnace Names that can be applied to a test result when the test result is being saved on the CAT-100. The **Edit Furnace Names** option allows you to change a selected Furnace Name. There is a maximum of 16 furnace names, each with a maximum of 32 characters in the name.

**View Operators** (Figure 71). Similar to the View Furnaces option, this option, when selected, displays the list of Operator Names that can be applied to a test result when the test result is being saved on the CAT-100. The **Edit Operator Names** option allows you to change a selected Operator Name. There is a maximum of 16 operator names, each with a maximum of 32 characters in the name.
Temperature Scale
Using this option (Figure 57), you can toggle the temperature units between degrees Fahrenheit (°F) and degrees Celsius (°C).

Data Menu
The Data menu (Figure 58) contains the Sort and Filter options. These options are used to change how data is displayed in CAT-100 View.

Sort
The Sort window (Figure 59) contains advanced options for arranging data. As explained in the Sorting Data in the Main Screen View section on page 39, the main screen provides sorting options. The Sort menu provides additional functionality for sorting data, allowing for three “layers” of sorting.

As an example, if the settings in Figure 59 are applied, data will be sorted first by Test Number in ascending order, second by Furnace Name also in ascending order, and third by Coil %C also in ascending order.

Filter
The Filter window (Figure 60) is used to set conditions for determining what data is displayed on the main screen and what data is not displayed.
The following operators are used in evaluating conditions:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>Is equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Is NOT equal to</td>
</tr>
<tr>
<td>&lt;</td>
<td>Is less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>Is greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Is less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Is greater than or equal to</td>
</tr>
</tbody>
</table>

Table 5 - Operators used in Filter window and their meanings

**Users Menu**

The **Users** menu (Figure 61) contains options for adding, removing, and modifying registered users of CAT-100 View. It also provides the ability to log in and log out users. The available options in this menu are **Log In**, **Log Out**, and **Manage Users**.

**Log In**

Use this option (Figure 62) to log in with a registered user’s credentials. **(NOTE: To set up a user, use the Manage Users option.)**

**NOTE:** If you have forgotten your login info, contact SSi for a login override code.
Once you’ve logged in a user successfully, that user and the user’s type will be displayed in the upper left hand corner of the CAT-100 View main screen (example in Figure 63).

Log Out
Use this option to log out the currently logged in user.

Manage Users
This option allows you to add, remove, and modify registered users. The access levels possible are Operator, Supervisor, and Administrator. Operator and Supervisor access levels allow for the deletion of test results from CAT-100 View. Administrator access is required to add, remove, and modify users. The exceptions to the Administrator access requirement are in two cases:

1. **No users have been added.** If no users have been added, one user may be added for the first time. **It is recommended to add at least one user with Administrator access before adding any others.**

2. **Users have been added, but no Administrator level users have been added.** If users have been added, but none of the users have Administrator access privileges, then the existing users have Administrator level access by default. Once an Administrator level user has been added, only users with Administrator access privileges will be able to add, remove, or modify other users.

Figure 64 illustrates an example of adding a user to CAT-100 View.

Help Menu
The **Help** menu (Figure 65) provides the ability to check for (and, if available, download) updates to the CAT-100 View software; it also provides information on the currently installed CAT-100 View version and software update history.
Check for Updates
This option will check the Internet for updates to the software and, if an update is found, give you the option to download and install it. It is recommended that you keep your software up-to-date and download updates when they are available.

About
The About screen provides information on the specific software version as well as a revision history for the software.
Troubleshooting

The CAT-100 is designed to provide accurate results testing procedures and conditions are consistent with the product’s design. When problems or discrepancies are encountered, they can often be corrected. The table below provides a list of potential problems that may be encountered, possible causes, and corrective actions that may rectify the problem.

**WARNING!**

When troubleshooting, follow all proper safety precautions. Use proper eye protection and hand protection at all times.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Causes</th>
<th>Possible Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wire breaks at any point in the procedure</td>
<td>Coil cooled too quickly</td>
<td>When removing insertion rod, follow procedure exactly as shown in Cooling Down and Removing the Insertion Rod section on page 15</td>
</tr>
<tr>
<td></td>
<td>Wire stretched beyond design limitations</td>
<td>Avoid stretching wire excessively</td>
</tr>
<tr>
<td>% Carbon indicated by CAT-100 differs by more than 0.03% from Process Variable shown by instrumentation at the time wire was exposed to testing atmosphere</td>
<td>Wire soaked too early in soak cycle</td>
<td>Insert wire coil into testing atmosphere during final one-third of soak cycle.</td>
</tr>
<tr>
<td></td>
<td>Emery cloth not applied to wire after soaking</td>
<td>Perform a test of a new wire, closely following the instructions in Using the Emery Cloth on the Steel Wire Coil page on 16</td>
</tr>
<tr>
<td></td>
<td>Variability in % Carbon levels in testing atmosphere</td>
<td>Ensure that testing atmosphere remains consistent during test. Temperatures, % Carbon, and other parameters should not change significantly while wire is exposed to testing environment. Furnace should be in a soak state for a minimum of one hour.</td>
</tr>
<tr>
<td></td>
<td>Testing procedure not followed correctly</td>
<td>Calibrate CAT-100 and re-test using an unused wire, following instructions exactly as indicated in manual</td>
</tr>
<tr>
<td></td>
<td>Instrumentation error</td>
<td>Contact equipment manufacturer or distributor</td>
</tr>
<tr>
<td>% Carbon indicated by CAT-100 differs by more than 0.03% from Process Variable shown by instrumentation at the time wire was exposed to testing atmosphere [Continued]</td>
<td>Incorrect Coil Factor entered</td>
<td>Ensure that the correct Coil Factor is entered during the testing procedure; see Entering the Coil Factor section on page 8.</td>
</tr>
<tr>
<td>Carbon Potential is not within the effective range of 0.1% to 1.3%</td>
<td>Actual Carbon Potential is not within the effective range of the unit</td>
<td>% Carbon shown must be within the effective range in order to be reliable. A different method of measuring Carbon Potential may be needed in such a case.</td>
</tr>
<tr>
<td></td>
<td>Soak time too long or too short</td>
<td>Re-test using an unused wire. Ensure that soak times shown in Table 2 are applied as indicated.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Causes</td>
<td>Possible Corrective Actions</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Wire becomes detached from insertion rod during soak in testing atmosphere</td>
<td>Unsecured attachment</td>
<td>Before inserting rod into testing atmosphere, verify that wire coil is in place securely for testing, that rod screw is securely tightened, and that protective cage is securely in place on the rod.</td>
</tr>
<tr>
<td>Reading is not stored when “Store” is pressed on CAT-100 touch screen</td>
<td>Pressure on screen not hard enough</td>
<td>Increase pressure of contact with screen. Take care not to cause damage to screen or protective film.</td>
</tr>
<tr>
<td></td>
<td>Interference from protective film over screen</td>
<td>Verify that spacing between protective film and touch screen allows for contact with touch screen</td>
</tr>
<tr>
<td></td>
<td>No reading to store</td>
<td>Verify that a test result was generated when wire coil was connected to binding posts on CAT-100. If not, reconnect wire to binding posts and observe reading again.</td>
</tr>
<tr>
<td></td>
<td>Internal storage error</td>
<td>Call SSi Technical Support at (513) 772-0060</td>
</tr>
<tr>
<td>Test results not displaying correctly in Test Results screen</td>
<td>Internal storage error</td>
<td>Call SSi Technical Support at (513) 772-0060</td>
</tr>
<tr>
<td>Can’t log in to CAT-100 View software.</td>
<td>Forgot login information for CAT-100 View software.</td>
<td>Contact SSi for Login Override Code.</td>
</tr>
</tbody>
</table>
### Table 6 - Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Causes</th>
<th>Possible Corrective Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAT-100 View software cannot connect or access data from CAT-100 unit&lt;br&gt;&lt;br&gt;&lt;em&gt;(If connecting through Ethernet)&lt;/em&gt; Ethernet connection issue</td>
<td>Ensure that the PC and the CAT-100 are connected to the same computer network and that the needed computer network settings (such as subnet mask and gateway) are correct. Ensure that both the PC and the CAT-100 have network connectivity. Consult with your IT/network administrator if needed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;br&gt;&lt;br&gt;&lt;em&gt;(If connecting through USB)&lt;/em&gt; USB connection issue</td>
<td>Ensure that the USB port on both the PC and CAT-100 are working properly and that the USB driver needed for use with the CAT-100 is installed properly. If needed, contact your IT administrator for assistance, or call SSi at [513] 772-0060.</td>
</tr>
</tbody>
</table>

If you experience problems and cannot find the solution after troubleshooting, please call SSi Technical Support at [513] 772-0060.
Warranty

Limited Warranty for Super Systems Products:

The Limited Warranty applies to new Super Systems Inc. (SSI) products purchased direct from SSI or from an authorized SSI dealer by the original purchaser for normal use. SSI warrants that a covered product is free from defects in materials and workmanship, with the exceptions stated below.

The limited warranty does not cover damage resulting from commercial use, misuse, accident, modification or alteration to hardware or software, tampering, unsuitable physical or operating environment beyond product specifications, improper maintenance, or failure caused by a product for which SSI is not responsible. There is no warranty of uninterrupted or error-free operation. There is no warranty for loss of data—you must regularly back up the data stored on your product to a separate storage product. There is no warranty for product with removed or altered identification labels. SSI DOES NOT PROVIDE ANY OTHER WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OF IMPLIED WARRANTIES, SO THIS LIMITATION MAY NOT APPLY TO YOU. SSI is not responsible for returning to you product which is not covered by this limited warranty.

If you are having trouble with a product, before seeking limited warranty service, first follow the troubleshooting procedures that SSI or your authorized SSI dealer provides.

SSI will replace the PRODUCT with a functionally equivalent replacement product, transportation prepaid after PRODUCT has been returned to SSI for testing and evaluation. SSI may replace your product with a product that was previously used, repaired and tested to meet SSI specifications. You receive title to the replaced product at delivery to carrier at SSI shipping point. You are responsible for importation of the replaced product, if applicable. SSI will not return the original product to you; therefore, you are responsible for moving data to another media before returning to SSI, if applicable. Data Recovery is not covered under this warranty and is not part of the warranty returns process. SSI warrants that the replaced products are covered for the remainder of the original product warranty or 90 days, whichever is greater.
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Description</th>
<th>Date</th>
<th>MCO #</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Initial Release</td>
<td>11/25/2013</td>
<td>2131</td>
</tr>
<tr>
<td>A</td>
<td>Added PC software section; updated Calibration section; updated specs and Parts List</td>
<td>3/7/2014</td>
<td>2136</td>
</tr>
<tr>
<td>B</td>
<td>Added Coil Factor and relevant procedures</td>
<td>4/4/2014</td>
<td>2139</td>
</tr>
<tr>
<td>C</td>
<td>Updated manual for redesigned insertion rod</td>
<td>5/21/2014</td>
<td>2149</td>
</tr>
<tr>
<td>D</td>
<td>Added extended insertion rod, removed extension information, changed calibration screen info to reflect 5 min wait time and countdown timer, fixed error percentage decimal place</td>
<td>10/20/2016</td>
<td>2198</td>
</tr>
<tr>
<td>E</td>
<td>Added close up of binding posts and clarifying text for coil insertion</td>
<td>2/26/2018</td>
<td>2230</td>
</tr>
<tr>
<td>F</td>
<td>Added connector information for insertion rod</td>
<td>3/8/2018</td>
<td>2231</td>
</tr>
<tr>
<td>G</td>
<td>Added login override info</td>
<td>9/7/2018</td>
<td>2239</td>
</tr>
</tbody>
</table>